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Preface

The Job Costing module in Payroll Africa is supplemental to the Costing module in
Donkerhoek Data's Farm Management Africa software. Still, it may be used as a standalone
cost-estimation utility.

The purpose of the Job Costing module is to break down each employee's time spent
working into its different components and to associate an hourly rate to each component. It
is then possible to estimate the total cost of each job type across all employees.

The estimation of total cost per job type is instrumental in the labor industry. These
estimations often determine future budgets for projects requiring labor or help determine
whether a project is currently running under or over budget.



Payroll Setup

Before using the Job Costing module, a few things need to be set up first. Read through the
following two sub-sections to understand how to correctly set up your Piecework Categories
and the Allocation Export File options.

In order to use the Job Costing module, you will need a correct Piecework Category setup.
Go to Piecework = A Piecework Categories:

Block T Activity T Group

Block
[*Code |Description |
i [Mane

4

G 2
Gh 3
G 4
Gk &
GM &
GM 7
GM &
GM 3

(=)= e A T P )

fidd ‘ Edit | Delete Change Category Erint Close " desrkon
Heading Screen &b

Ordering and Naming of Piecework Categories

Your Piecework Categories may be described however you wish. They do not need to be
named “Block”, “Activity” and “Cultivar” as depicted here. The descriptions do not affect
the application logic.

The ordering of the Piecework Categories is most important: if “Block” is the first category
you select on the clocking device, Payroll Africa expects the first Piecework Category to be
set up with the “Block” entries. Likewise, if “Activity” is the second category you select on
the device, the second Piecework Category in Payroll Africa should have the “Activity”
entries.

Entry Code Rules

When setting up entries, try to use “1”, “2”, “3", etc. for the entry Code values, instead of
“01", “02", “03”, etc. as the Job Costing module will strip any leading zero-padding
characters while processing the jobs.

For systems that already have their Piecework Categories set up with leading




zero-padding characters, the Job Costing module will interpret all “01” values as “1”, all
“02” values as “2”", etc.

This behaviour is due to the fact that most hardware already strips the leading zero
characters before the data is imported into Payroll Africa.

NB: Only use numeric values when setting up codes. Special characters and alphabetic
characters A through Z are not allowed.

The Job Costing module allows for the creation of two export files during Period End
that instructs the FMA Costing module how the total hours and wages for the pay period
are split across different Piecework Categories and employees.

For one of these files, a specific setup is required.

Go to Clock Systems - M Job Costing = D Edit Allocation File Setup:

i Edit Allocation File Setup

Day Hours A035+4036+4046+4047+AD57+4058+4068+A063+4079+4080

Day W age 4037+A048+4053+4070+4081

Dvertime! Hours  (A080+4091

Overtirne Wage (4092

Owertime? Hours

Overtima? 'Wage

Fiecewark Hours

Piecewark 'wage

Bl Bl EL B B EE B EEE

i LCancel Save

Since the design of the pay screen varies between different systems, there is no
standard way for Payroll Africa to determine which pay field values to include in the
calculation for the FMA Allocation Export File.

Donkerhoek Data strives to ensure that this setup remains correct after any system
changes, but when starting the use of the Job Costing module, it is imperative that this
setup be done correctly.



Next to each section on the Edit Allocation File Setup screen you'll find two buttons: the
first allows you to select which fields to include in that section, while the second will
allow you to clear the currently selected fields.

Click the “..." button next to each section, and select all the pay screen fields that are
applicable to that section. For instance, when setting up the “Day Hours" section, select
all pay screen fields that are used to determine an employee’s day hours on their payslip.
When setting up the “wage” sections, select all the fields that are used to calculate the
employee’s wage for that category.

NB: Be careful not to select fields that are already included in the value calculations of
other fields. For example: do not select the different “hour” fields if you already have a
“total hours” field which adds all the hour fields together. Always try to use formula
fields if possible.

After the Job Costing module is activated, all employee profiles have to be modified to set
how their pay is calculated. If you already use ETI, this information will be set
automatically.

Go to each employee profile, and select the ETI/Job Costing tab:

General ETI/Job Cost.

Faprment per )
Hour/D ay Min. W age Actual ETI Wage

+| |19 {19.00

SEZ {MOM - Mon SEZ Emplayer >l

Ensure that the Payment per Hour/Day is set correctly. This value should be “Hour” when
an employee is paid on an hourly basis, and “Day” when an employee is paid on a daily
basis. This information is required to calculate the estimated job costs when you have
employees that are paid both Hourly and Daily on the same Payroll Africa system.

NB: If the Payment per Hour/Day setting is set to the incorrect value, the cost estimation
calculations for the relevant employees will be incorrect.



Job Costing Calculations

The bulk of work done by the Job Costing module happens when calculating the Jobs for
each day.

The calculation process looks at all the clock records for an employee on a specific day and
determines the type, duration and categories of work done. It then determines the
employee’s hourly wage for that day, and generates a cost estimate for each job. It totals all
the jobs’ costs and hours to give you a detailed breakdown of how much was spent where,
doing what, for any particular day.

All costing calculations are based on the actual wage the employee gets paid (as defined on
the pay input screen and on the employee profile screen, under the ETI/Job Costing tab):

General ETI/Job Cost. |

Fapment per )
Hour/Day Min. "W age Actual ETI W age

How EAMRIE {19.00

SEZ [NOM - Mon SEZ Emplayer B

Examples of how the hours calculated on the Validate Data graph is converted into Jobs on
the Job Costing screen can be seen below:

An employee does the same job throughout the day. They work on Block 18, performing
Activity 1 - Picking. The employee had a break between 13:00 and 13:30.

On the validate data graph you'd see:

g 3 1w 11 12 13 14 15 16 17
) e——

When calculating the jobs, it would be represented like this:

| Block: | Asictivity |Start Time  |End Time | Total Time | Total Cost ||
18- GM &0 1 07 - Picking 074500 130000 051500 39.75
18- GM &40 1 07 - Picking 133000 170000 033000 EE.50

08:45:00 166.25



An employee pruned on Block 2 from 11:38 until their break at 13:00. After their break, they
started sanitizing on Block 3 until 16:30.

On the validate data graph, you'd see this:

11 12 12 14 15 16 1

And when calculating the jobs, it would be represented like this:
| Block | ctivity | Gtart Time  |End Time | Total Time | Total Cost [_
02-GM 2 02 - Pruning 113801 1300000 01:21:59 25.95
03 - GM 3 03 - Sanitation 1330000 163008 03:00:06 A7.03

04:22:05 82.99

An employee started working normal hours at 06:30 until their break started at 12:30. They
were booked off sick for the rest of the afternoon, and the graph was manually updated
stating the sick status.

The graph would look like this:

B 7 g 3 o 11 12 13 14 15 16 17

_——__

While the calculated jobs would resemble the following:

| Blocks |Activity | Start Tirne | End Time | Tatal Time [ Tatal Cost l Tirne: Type

0 - Hone 0 - Hone (g 30:00 12:30:00 (6 0000 51,36 Mormal
0 - Hone 0 - Hone 14:00:00 17:00:00 03:00:00 2AE8 5
09:00:00 77.041

A Note on Absent Hours

Absent With Leave and Absent Without Leave, although editable on the Validate Data graph,
will never calculate or export in the Job Costing module. This is due to the fact that we don't
associate monetary values to Absent hours on payslips. Those hours are, in effect, excluded
from the cost calculations and cannot be allocated in the Farm Management Africa software.



Calculate Jobs For The Current Pay Period

There are two ways of performing the job costing calculations:

The first way is to do it while you're validating data on the Validate Data graph.

Once the Job Costing module is activated on your Payroll Africa system, open any day on the
Validate Data screen. You'll find the Job Costing button below the graph section. Clicking on
it will bring up the Job Costing screen, where the various jobs for the day will be displayed.

i Select Employees -

o |ndividual s

; " Select m
Al .Tlmes
 worked Edit 5td Times

7 hlabwdarlk-ad

Your Coin Group selection on the Validate Data graph determines the default Coin Group
filters applied to the Job Costing screen automatically.

NB: Please remember to shift all employees to Standard Times before editing/viewing the
Job Costing information. Clock records must be fully validated and finalized before the Job
Costing calculations are performed in order to get the correct results.

Alternatively, you can perform the calculations by using the Clock Systems = M Job Costing
- A Edit Current Allocations option.

Clock Systems Piecework Reports  Payment Transfers  Peried End  IRP3/ T3(a)

A Standard Times and Criteria r‘ﬁ _g‘_\\
B Download Data % ﬂ A

C Process Data :Data  Validate Data CurrentReport €
D Validate Data > J pajaccsys DEWS
E Reports »
F Transfer Data >
G Employees' Coins >

H Delete Data by Date

| Manual Clock cards ¥

Jmport »
K Clear Clock records by Date

M Job Costing > A Edit Current Allocations

B Wiew Finalized Allocations
C Create Allocation File »

D Edit Allocation File Setup



Please note that using this option implies that you've already validated the data. Only fully
validated days will be displayed in the Edit Current Allocations option. When opening from
the Validate Data graph, the validation happens automatically, whereas when opening from
the Clock Systems menu, validation does not happen automatically.

Ls = &l

o - tic [E=

ME: Only fully vahdated dates can be changed.

Date {2020.06-04 |

From Coin Group |EI1 - Seasonal Summer 9

To Cain Group ||:|4 - Ficking support

Ll Lo

Cancel | Chanhge

From this dialog, you may select which date to calculate and edit, as well as the default Coin
Group filters that are applied to the Job Costing screen automatically.

Please see the next section for details on the workings of the Job Costing screen.



The Job Costing Screen

Upon choosing to calculate the Job Costing, you are presented with the Job Costing screen:

(5 1ob Conting [= o))
Block Activity Coin Group Clock Date
[o:mene 5 | e K] [oesimimniivinte =l [mmosie -] Gelet Enployess Filter | Select Al | Deselect Al | F arveic Ealenames
[24-amava7 _=|[05-unkown =] [02-zeasonal winter 8 |
| [Ho [Date [Employee | Cain Group [Biock [Activity [Stat Time [End Time  [TotalTime | Houly Rate |OT Factor | Total Cost [P/ Units | Time Type
2 20200616 Zolsile Bad 0Z - SeasoralWinter 8|01 -GM 1 01 - Picking 074500 130000 051500 15.00 10 9575 1.0 Fiecework
2 20200616 Zolisle Bad 0Z - Seasonal Winter 8 | 02-GM 2 02 - Fruning 123000 142007 005007 13.00 10 1687 1.00 Flecawork
2 20200616 Zolsile Bad 02- Seasonal Winter 8 | 03-GM 3 01 - Picking 142007 170000/ 023353 19.00 1.0 5063 1.00 Fiecework
08:45:00 166.25 3,00

Reports: [Select 2 Azpor - Bt 'Tazmuagw Units %a%%;_ lwmm

When entering the Job Costing screen, you may encounter the following warning message:

lob Costing >

F The following employees have zero total hours, Please make
L’E sure that the data has been fully validated and that all
necessary changes and corrections have been made before
proceeding:

73 - Secilia Mdaipelenga Matilifa

This means that the employee clocking data is incomplete (missing in or out clock) for the
listed employees. You will need to manually fix the clocking data using the Validate Data
graph, or retry downloading your clocking data. When you've completed all fixes, you may try
to enter the Job Costing screen again.

If all clocking data is valid and the screen opened without warning, you'll find various options
and filters to choose from. Let's look at the options from the top-left to bottom-right:

At the top-left you'll find a set of filters for the Piecework Categories. These filters contain
the entries as set up in your Piecework Category setup (see the Payroll Setup section.)

Block Achivity
ID-NDne ;IIU-NDI‘H? ;I
|24-|3M AVOT = || 05 - Unkawn -

10



You may change these to filter the displayed data in the Job Costing grid.

By default the Coin Group filters are set outside the Job Costing screen. When opening from
the Validate Data graph, the Coin Group filters are automatically set to the same filters as set
on the graph. When opening from the Clock Systems menu, they are chosen just before the
screen opens. See Calculate Jobs For The Current Pay Period

Coin Group
| 02 - Seasonal Winter & j
| 02 - Seazonal Winter 8 d

You may change these filters to filter the data displayed in the grid.
Date Filter

The Job Costing screen limits the viewable dates to one at a time. This makes it easier to
reason about the data you're seeing. The Clock Date filter allows you to choose which date
you want to view or calculate jobs for.

Clock Date
20200616 v

When opening from the Validate Data graph, the Clock Date value is automatically set to the
same date as you have open on the Validate Data graph. When opening from the Clock
Systems menu, the date is selected just before the screen is opened.

In the event that you want to further filter a specific subset of employees or a single
employee, you may use the Select Employees function. Clicking here will open up a list of
employees from which you can select.

LSelect Employees

Please note that this only filters the grid, and does not affect the selections in the grid itself.

Filter Action

Filter

Once you've made your filter selections, you may click Filter to apply the selection.

Global Grid Selection Controls

In the event that one or more employees clocked on the incorrect set of categories, you may
change those categories from the Job Costing screen. This will modify the clock records to
have the correct category values. As a result, each job in the grid is selectable.

11



You may use the Select All and Deselect All functions to globally select or deselect jobs in
the grid.

Select Al ‘ Dezelect Al ‘

Once you've selected the applicable jobs you want to change, use the Change Categories
function.

Change Categories

It will present you with a screen asking for the new category values:

B3 Piecework Categories

Block 111 -GM 11 |

sciviy R -

[5]:4 ‘ LCancel |

Here you may choose whether you want to change only one or both of the values. Leaving a
value blank means not making a change to the existing value.

The grid will resemble the following when there are valid jobs for the current filter criteria:

Mo |Date | Employee | Coin Group | Bl [ activity |Start Time  |End Time | Total Time [ Totsl Cost | Time Tupe

_____ 2| 2020-06-16 | Zolisile Badi | 02 - Seasonal Winter 8 01 - G 1 M - Ficking 074500 13:00:00 05:15:00 9975 Piecework

2| 2020-06-16 | Zolisile Badi | 02 - Seasonal Winter 8 | 02 - G 2 02 - Pruning 1330:00 14:20:07 0050:07 15.87 | Piecework

2| 2020-06-16 | Zolisile Badi | 02 - Seasonal Winter 8 | 03 - GM 3 01 - Picking 14:20:07 17:00:00 023353 50.63| Piecework
08:45:00 166.25

You'll notice the employee number, the date, employee name, coin group, piecework
categories, times, totals, cost estimates and types. [Some columns omitted for brevity]

After all the jobs for each employee, a yellow line is added to indicate the totals for that
employee for the filtered criteria (date and categories).

You may double-click on a line in the grid to select it, or use the Select All or Deselect All
functions to globally toggle the selections. When a line is selected, it will have a “+” symbol
at the start of the row:

|N|:| |Date |Em|:u|n
+ 2 2020-06-16 | Zolisi
2 2020-06-16  Zolisi

+ 2 2020-06-16  Zolisi

12



Overtime Selection

Note that when the last part of the day is overtime, selecting the job preceding the
overtime job will automatically include all following overtime jobs in the selection as
well. This is done because the overtime jobs are typically determined artificially(i.e. the
employees usually don't physically clock to start working overtime), and usually match
the preceding job’s Piecework Categories. When editing the preceding job, the overtime
parts should also be edited.

Should the overtime part of the day actually be allocated towards another set of
Piecework Categories, you may select the overtime parts individually and modify their
Piecework Categories without affecting the preceding job.

At the bottom-left of the screen you'll find the reports selection. Please see the reports
section of the manual for more information.

Reports: ] Select a Report L] Prirt

Job Costing Report
Haurs Shart Bepart

Grand Totals

At the bottom right of the screen, the totals for all the currently-filtered jobs are displayed.

T atal P Units Total Tirne T atal Cost
13.00 |08:45:00 | 166.25

These values indicate the total Piecework Units, Total Time and Total Cost for the selected
filter range (date and categories).

13



Viewing Job Costing For Previous Pay Periods

It is possible to view the Job Costing calculations done in a previous pay period, or for dates
that are already transferred. Go to Clock Systems - M Job Costing = A View Finalized
Allocations

Clock Systerns = Piecework  Reports  Payment Transfers  Period End  [RP3 /| T3(a)

& Standard Times and Criteria r"ﬁ s
' [ €
B Download Diata __ \‘v(:r'"

C Process Data sData Validate Data CurrentReport  (

[ Validate Data ¥ _J pajaccsys l‘ﬁ ax}gs.
E Reports >
F Transfer Data >
G Employees' Coins *

H Delete Data by Date

| Manual Clock cards ¥

Jmport *
K Clear Clock records by Date

M Job Costing » A Edit Current Allocations

B View Finalized Allocations
C Create Allocation File >

D Edit Allocation File Setup

You'll be presented with a dialog asking the date and coin group filters:

Iy

F View Finalized Allocations

MB: Only dates already ranzferred to the pay
gcreen [in this pay period or previous pay periods]
can be viewed.

Date | 20200317 |

Fram Cain Graoup ]Eﬂ - Seazonal Summer 9 _:]
To Cain Group I|:|4 - Picking support

Cancel |

After you make your selection, you'll be taken to the same Job Costing screen as you would
normally have used while calculating the current allocations. The difference here is that you
may not modify anything for records already transferred and finalized.

See The Job Costing Screen section for more details on what you'll see.

14



Reporting

Currently there are two available reports from the Job Costing screen: the Job Costing list
Report, and the Hours Short Report.

Reports: ] Select a Report L] Print

Job Costing Repaort
Hourz Short Report

The Job Costing Report is a printed version of the grid you see on the Job Costing screen.
Whatever is currently displayed in the grid, will be printed in the report. To change what the
report prints, you have to change the filters for the Job Costing grid.

ol Costing from 2020-06-16 to 2020-06-16

& Date Employee Block Acfvity Coin Group Start End Tot Time: Tot Cost Units.

2 2020-06-16  Zokséie Badi 01-GM 1 01 - Picking 02 - Seasonal Winter 8 07:45.:00 13:00:00 05:15:00 w05 1.00

2 2020-06-16  Zoksde Bad 02-GM2 02 - Pruning 02 - Seasonal Winter 8 13:30:00 14:20:07 00:50:07 1587 1.00

Z 2020-05-16  Zolsie Bad 03-GM3 01 - Picking 02 - Seasonal Winter § 14:2007 17:00:00 02:39:53 5063 1.00
08:45:00 16625 3.00
08:45:00 18625

This report calculates any hours short for the selected filter criteria.

Hours short from 2020-06-16 to 2020-06-16

&  Employes Cein Group Daste Daylengh Hours\Worked Hours Alocated  Hours Not Aflocaied Hours Worked Short

2 Zolicie Bad (02 - Seasonal Winter 8 0200816  08:45:00 084500 08:45:00 00:00:00 00:00:00

06:45:00 08:45:00 00:00:00 00:00:00

There are various time-related columns, each of which represent important information:

Day Length: The length of the day, as specified by the Standard Times & Criteria, for the Coin
Group the employee was in at the time of work.

Hours Worked: The total hours worked across all filtered jobs.

Hours Allocated: The total hours worked where the Piecework Category values were set
correctly, and the system knows what type of work the employee performed. These hours
will be correctly allocated when exporting to Farm Management Africa.

Hours Not Allocated: The total hours worked where the Piecework Category values for the
jobs were not set correctly. The system does not know what work the employee performed
for this portion of the day. This will show up as unallocated hours and wages when exporting
to Farm Management Africa.

Hours Worked Short: The difference between the day length and the Total Hours Worked
column.

15




Export Costing For The Active Pay Period

Once you've transferred your clocking data to the pay screen as you normally would, you
then have two options of exporting the costing information to Farm Management Africa: wait
until period end where Payroll Africa will automatically export the information as required, or
use the Clock Systems menu to manually export the information before period end.

NB: NB: All Active employees are processed when exporting Job Costing data, and not only
employees that have clocking data on the Validate Data graph. This means that it is possible
to have hours and wages exported for employees with information on their Pay Input screen,
where there may not be allocation data from your clocking systems for these employees.
This will result in unallocated hours and wages in the Farm Management Africa system. You
will have to manually allocate those values in the Farm Management Africa system.

When closing off your pay period, one of the steps will automatically export the costing
information to Farm Management Africa. A progress dialog will be shown during period end
to indicate the export progress.

Recalculating payment information

Recalculating payment infarmation for employes 320 Cancel

In the event that you want to export the costing information before period end, you may do
so by going to Clock Systems - M Job Costing = C Create Allocation File = A Current Pay
Period:

Clock Systems  Piecework Reports  Payment Transfers  Period End  IRP5 /IT3{a) Other Close

A Standard Times and Criteria ﬁ . - Y
& % W A
B Download Data N & | \i:

C Process Data sData Validate Data CurrentReport  Company Reminders Hely

i ies | patacesys | paysoft’ | @ fme, | 2 &
EReports ¥
F Transfer Data >
G Employees' Coins »

H Delete Data by Date

| Manual Clock cards ¥

Jimport >
K Clear Clock records by Date
L Remote Clocking >

M Job Costing > A Edit Current Allocations

B View Finalized Allocations

C Create Allocation File > A Current Pay Period

D Edit Allocation File Setup i Rievious Bay Periads

16



Using this option will automatically bring up a disclaimer explaining that you are exporting
information that may still be changed before the period end process exports the information
again:

Payroll Africa >

Please note: you are creating the allocation files for the

I . current pay period. Since this pay period has not been closed
[ off yet, the information used to create these files may still
change.

These files do not represent the final allocation figures,

Clicking OK will allow you to continue the export process. The same dialog that is shown
during the period end calculation of costing information will be shown here:

o "

Create allocation files

Create allocation file for 2020-02-23

Calculating hours allocation for employes 5132 for date 2020-01-29

In addition to regular hours worked, the following Time Types on the Validate Data graph will
also be exported as Normal Time to Farm Management Africa:

Leave

Sick Leave

Compassionate Leave
User-customizable time types (1-5)

This means that the Normal Hours value in Farm Management Africa will be equal to the
sum of all the above-mentioned hour types (transferred from the Validate Data graph) plus
the actual normal hours total.

NormalHours = ActualNormalHours + Leave + SickLeave + CompLeave + Typel...Type5

17



Export Costing For Previous Pay Periods

When starting to use the Job Costing system for the first time, it may be necessary to create
back-dated export files for the pay periods where Job Costing was not activated on your
system. This is one of the reasons why you may re-export Job Costing information for

previous pay periods.

NB: Allocation Files can only be recreated for pay periods where the Job Costing module was
active. If you are starting with Job Costing in this pay period, you will only be able to recreate
Allocation Files from this pay period going forward.

To do this, go to Clock Systems = M Job Costing = C Create Allocation File = B Previous

Pay Period:

Clock Systems  Piecework Reports  Payment Transfers  Period End  IRP3/1T3(a) Other Close

A Standard Times and Criteria

B Download Data
C Process Data

D Validate Data
E Reports

F Transfer Data
G Employees' Coins

H Delete Data by Date

| Manual Clock cards

Jimport
K Clear Clock records by Date
L Remote Clocking

M Job Costing

.

>

¢ 0

s Data

Validate Data CurrentReport  Company Reminders Helg

payaccsys

paysoft” |@ &, | 2 &

A Edit Current Allocations

B View Finalized Allocations
C Create Allocation File

D Edit Allocation File Setup

3 A Current Pay Period
B Previous Pay Periods

A dialog asking the period range to export will be shown:

Recreate allocation files for previous periods

From |3015.03.25

To |2020-01-26

Cancel

Clicking Create Files will start the re-creation process. A progress dialog will be shown to
indicate the progress for each pay period in the selected range:

P>

.Create allocation files

Create allocation file for 2020-02-23

Calculating hours allocation for employes 5192 for date 2020-01-29
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